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IV – TECHNIQUES DE MODELISATION (Modelling in Blend er) 
La modélisation et l'art de créer une surface qui imite la forme d'un Objet du monde réel ou correspond à votre vision d'un 
Objet abstrait. Beaucoup de gens utilise la 'modélisation par boîtes' (box modelling) qui part d'un simple cube de base, et utilise 
l'extrusion et le déplacement des vertices/arêtes pour créer un Maillage plus grand et plus compliqué. Pour des Objets plats, 
comme des murs ou des plateaux de table, vous pouvez utiliser la 'modélisation par courbes' (curve modelling) qui définit le 
contour en utilisant des courbes de Bézier ou Nurbs, et ensuite les extrude jusqu'à l'épaisseur souhaitée. L'une ou l'autre 
méthode sont totalement supportées dans Blender en utilisant ses outils de modélisation.  
 

4.1. Les Objets 
 

4.1.1.  Le mode Objet (Object Mode) 
La géométrie d'une Scène est construite à partir d'un (ou plusieurs) Object(s). Par exemple, des Lumières (Lamps), des 
Courbes (Curves), des Surfaces, des Caméras, des Maillages (Meshes) et les Objects de base décrits dans le chapitre Objects 
Maillés (Mesh) de Base. Chaque Object peut être déplacé, pivoté et retaillé en mode Object ( ). Pour réaliser 
des modifications plus détaillées à la géométrie d'un Object, vous pouvez utiliser le mode Edit .  
 

Une fois que vous avez ajouté un Object de base, vous passez automatiquement en mode Edit  si l'Object est 
un Maillage (Mesh), une Courbe (Curve) ou une Surface. Vous pouvez revenir en mode Object en pressant 
TAB. Le wireframe de l'Object (s'il en existe un) doit alors apparaître en rose, ce qui indique qu'il est 
maintenant sélectionné et actif (image ci-contre).  
 

 

L'outil Erase (Effacer) 
Mode : mode Edit  ou mode Object – Raccourcis : X ou DEL  - Menu : Object>Delete. 
 

Vous pouvez utiliser X (ou DEL) pour effacer des Objects.  
 

L'outil Join  (Joindre) 
Mode : mode Object - Raccourci : CTRL J  – Menu : Object >Join Objects.  
 

Vous pouvez utiliser CTRL J  pour réunir tous les Objects sélectionnés en un unique Object (les Objects douvent être du même 
type). Le point central du l'Object résultant est obtenu à partir de l'Object précédemment actif. Utiliser cet outil est équivalent à 
l'ajout de nouveaux Objects tout en étant en mode Edit .  
 

L'outil Select Links (Choisir des Objets Liés) 
Mode : mode Object – Raccourci : SHIFT L  – Menu : Select>Select Linked.  
 

Vous pouvez utiliser SHIFT L  pour sélectionner tous les Objects qui partagent un lien avec l'Object actif. Vous pouvez ainsi 
sélectionner tous les Objects qui partagent une IPO, des données, un matériau ou une texture : 
· Object Ipo : Permet de sélectionner des Objets qui partagent des informations IPO. 
· ObData : Permet de sélectionner des Objets qui partagent des informations Data. 
· Material  : Permet de sélectionner des Objets qui partagent des informations Material . 
· Texture : Permet de sélectionner des Objets qui partagent des informations Texture. 

 
 

4.1.2. Sélectionner des Objets  
 

Sélection d'un Point (Point Selection) 
La façon la plus courante de sélectionner un élément est de cliquer dessus avec RMB, ce qui remplacera la sélection existante 
par la sélection du nouvel élément. Pour ajouter des éléments à la sélection existante, gardez SHIFT appuyé tout en cliquant 
RMB. Cliquer de nouveau sur un élément sélectionné le désélectionne. 
 

En mode Object, le dernier élément sélectionné est appelé "Object Actif".  
 

ALT RMB  fait apparaître une liste nominative des Objets. CTRL RMB sélectionne les Objets à partir de leur centre.  
 

L'outil Border Select (Rectangular or Border Select) 
Mode : mode Edit  / mode Object – Raccourci : B – Menu : Select > Border Select.  

 

Vous utilisez une Boîte Englobante pour sélectionner un groupe d'Objets en dessinant un rectangle tout en maintenant enfoncé 
LMB . En faisant ceci, vous sélectionnerez tous les Objets qui se trouve dans ce rectangle (ou le touche). Si un Objet déjà actif 
apparaît dans le groupe, il deviendra sélectionné et actif.  
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Exemple : Dans l'image de gauche, 
une sélection par boîte englobante a 
été activée et est indiquée par un 
curseur à deux lignes pointillées 
croisées. Dans l'image du centre, la 
zone de sélection a été choisie en 
dessinant un rectangle avec LMB .     
 

Le rectangle ne couvre que les cubes A et B. Enfin, en relâchant LMB , la sélection est complétée (image de droite). 
 

Notez dans l'image de droite que le cube B est aussi sélectionné et actif. Ceci veut dire que le cube B était le dernier Objet actif 
avant l'utilisation de l'outil Border Select.  

 

Conseil Pratique : Une sélection par boîte englobante s'ajoute à la sélection précédente, donc afin de ne sélectionner que le 
contenu du rectangle, désélectionnez d'abord tout avec A. De plus, vous pouvez utiliser MMB  pendant que vous dessinez le 
rectangle pour désélectionner tous les Objets dans ce rectangle.  

 

L'outil Select Grouped 
Mode : mode Edit  / mode Object – Raccourci : SHIFT B.  
 

Cette fonction sélectionne d'autres items en se basant sur des propriétés de la sélection courante. L'outil Select Grouped en 
mode Object n'utilise que le Maillage actif comme base pour sélectionner tous les autres.  
 

Les options disponibles sont :   
· Children :  Sélectionne récursivement tous les enfants de l'Objet actif.  
· Immediate Children : Sélectionne tous les enfants de l'Objet actif.  
· Parent : Sélectionne le parent de cet Objet s'il en a un.  
· Siblings : Sélectionne les Objets qui ont le même parent que l'Objet actif. Ceci peut aussi être utilisé pour sélectionner 

tous les Objets de niveau racine (root) (Objets sans parent). 
· Objects of Same Type : Sélectionne les Objets qui sont du même type que l'Objet actif.  
· Objects on Shared Layers : Sélectionne les Objets qui partagent au moins un calque (layer).  
· Objects in Same Group : Les Objets qui font partie d'un groupe (affiché en vert avec le thème par défaut) seront 

sélectionnés s'ils sont dans l'un des groupes où se trouve l'Objet actif.  
 

4.1.3. Editer des Objets 
 

4.1.3.1. Déplacer des Objets (Moving (translating) objects) 
 

Mode : mode Edit  / mode Object – Raccourci : G – Menu : Mesh>Transform>Grab/Move. 
 

Pour déplacer un Object, il faut le mettre en mode Grab en appuyant sur G (image ci-contre). Les 
Objects sélectionnés seront alors affichés en wireframe blanc et pourront être déplacés à la souris 
(sans presser ses boutons). Pour confirmer la nouvelle position, cliquez LMB  ou pressez ENTER; 
pour abandonner le mode Grab, cliquez RMB ou pressez ESC. L'entête de la Vue 3D affiche la 
distance de déplacement.   
 

Contrainte selon un Axe (Axis constraint) 
Le mouvement peut être limité (contraint) à un axe qui est aligné avec l'un des axes du 
système de coordonnées globales, centré sur l'emplacement d'origine de l'Object dans le 
monde. La l'emplacement d'origine du cube B dans le monde est appelé C. Le centre du 
système de coordonées globales est appelé W; l'axe Z n'est pas visible.  
 

En limitant le mouvement à un axe global, vous limitez en fait le mouvement à une 
dimension. Les axes globaux alignés possèdent les code couleurs suivants :  

· l'axe X est rouge foncé et est appelé ici  X axis.  
· l'axe Y is vert foncé et est appelé ici W-Y axis.  
· l'axe Z est bleu foncé et est appelé ici Z axis.  

 
 

L'axe qui limite le mouvement est toujours mis en évidence avec un ton de couleur plus clair. Par exemple, l'axe Y est affiché 
en vert clair si le mouvement est limité à cet axe, appelé ici Y axis.  
 

Il existe a deux facons de limiter le mouvement : utiliser la souris ou utiliser le clavier.  
 

Utiliser la souris 
Pour containdre le mouvement en utilisant la souris, passez en mode Grab et déplacez l'Object tout en gardant MMB appuyé. 
En mode Grab, vous pouvez utiliser le système Gesture (reconnaissance de mouvement) pour pré-sélectionner un axe, en 
déplacant la souris dans une direction grossièrement alignée avec un axe global et ensuite, en cliquant et relachant MMB . Par 
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exemple, si vous déplacez la souris le long de ce qui apparaît visuellement comme étant l'axe X et que vous cliquez et relachez 
MMB , le mouvement de l'Object sera limité à l'axe global X.  
 

Vous pouvez aussi choisir de facon interactive l'axe de contrainte en déplacant la souris tout en gardant MMB  appuyé lorsque 
vous êtes en mode Grab. Les trois axes deviennent alors visibles avec une ligne guide qui émane del'emplacement original de 
l'Object, appelé C. Ce guide est dessiné sous forme d'une ligne blanche pointillée appelée S. Lorsque cette ligne guide est 
proche d'un axe, cet axe est mis en évidence par une couleur plus claire et l'Object est 'collé' à cet axe. Dans cet exemple, la 
ligne guide est proche de l'axe Y et le cube, appelé B, 'colle' donc à cet axe.  
 

Si vous gardez CTRL  appuyé tout en déplaçant l'Object, vous allez activer le mode Snap, et l'Object se déplacera d'un nombre 
entier d'unités (carreaux de grille). Le mode Snap prend fin quand vous relâchez CTRL , aussi assurez-vous de confirmer la 
position avant de la relacher. Pour obtenir un mode Snap plus fin, vous pouvez pressez à la fois CTRL  et SHIFT.  
Vous pouvez aussi contrôler le positionnement plus finement en gardant SHIFT appuyé tout en déplaçant la souris. De grands 
mouvements de souris seront convertis en de tout petits mouvements de l'Object, ce qui permet de bien ajuster sa position.  
 

La position des Objects sélectionnés peut être ramenée à la valeur par défaut en pressant ALT G . La position par défaut est 
l'origine du système de coordonnées globales.  

 

Utiliser le clavier 
Vous pouvez limiter le mouvement à un seul axe donné en appuyant sur X, Y ou Z. Une première pression limite le 
mouvement à l'axe global correspondant (Contrainte globale), comme avec MMB . Une seconde pression de la même touche 
contraint le mouvement selon l'axe local correspondant de l'Object même (Contrainte locale) et une troisième pression libére la 
contrainte (Pas de contrainte). L'axe contraignant le mouvement est affiché avec une couleur plus claire pour mieux visualiser 
la contrainte. Vous avez ci-dessous des exemples de contraintes selon l'axe X utilisant la touche X.  
 

 
Pas de Contrainte 

 
Contrainte Locale 

 
Contrainte Globale 

 

Un fois le mode Grab activé, vous pouvez entrer manuellement le déplacement de l'Object en 
tapant simplement un nombre. Cela modifiera l'entête de la Vue 3D comme le montre la figure 
ci-contre : 

 

 

Le nombre entré est une distance (par exemple : quelle distance depuis l'emplacement actuel de l'Object). Pensez à D comme à 
Déplacement, Delta ou Distance. Le nombre entré n'est pas une coordonnée globale dans la Scène.  
 

Par défaut, une entrée manuelle modifiera le champ X : voyez le champ appelé Dx dans l'image ci-dessus. Vous pouvez 
modifier l'entrée par défaut en utilisant TAB avant d'entrer un nombre. Par exemple, pour déplacer l'Object sélectionné de 4.4 
unités le long de l'axe Y,  vous devez suivre les étapes suivantes :  

· Passer en mode Grab.  
· Presser TAB une fois.  
· Taper 4.4.  

 

Pour déplacer l'Object de 3.14 unités selon l'axe Z, vous devez pressez TAB deux fois avant d'entrer un nombre. 
  
Pour le moment vous ne pouvez pas effacer un nombre incorrect. Vous devez recommencer à partir des valeurs originales. La 
touche BACKSPACE permet de rappeler les valeurs originales. Pressez ENTER (ou SPACE) pour finaliser et ESC pour 
quitter. Si vous désirez plus de flexibilité pour entrer manuellement les valeurs, voyez le chapitre Le panneau Transform 
Properties.  
 

Conseil Pratique : Vous devez utiliser le "." du clavier et pas le "." du pavé numérique pour entrer le point décimal.  
 

4.1.3.2. Faire Pivoter des Objets (Rotating objects) 
Mode : mode Edit  / mode Object – Raccourci : R ou système Gesture  - Menu : Mesh>Transform>Rotate.  
 

Vous passez en mode Rotate en appuyant sur R ou en utilisant le mode Gesture. Comme pour le mode Grab, vous faites 
pivoter l'Object avec la souris et vous confirmez avec LMB  ou ENTER. Vous pouvez abandonner avec RMB ou ESC.  
 

Pendant que vous faites pivoter l'Object avec la souris, l'angle de rotation est affiché dans l'entête de la Vue 3D : .  
 

Une rotation en 3D intervient autour d'un axe, et il existe plusieurs façons de définir cet axe. Mais en général, un axe est défini 
par une ligne directrice et par un point passant par cette ligne. Par défaut, l'axe est orthogonal à votre écran (c'est à dire que 
l'axe entre ou sort de votre écran). Si vous visualisez la Scène dans les vues Front , Side ou Top, l'axe de rotation sera parallèle 
à l'un des axe du système de coordonnées globales. Si vous visualisez l'Object sous un autre angle, l'axe de rotation présente 
aussi un décalage angulaire, qui peut facilement mener à des rotationss très déroutantes de votre Object. Dans ce cas, vous 
pourriez vouloir conserver l'axe de rotation parallèle à l'un des axes du système de coordonnées.  
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Contrainte de Rotation autour d'un Axe (Axis of rotation Constraint) 
Comme pour le mode Grab, vous pouvez contraindre la rotation autour d'un axe en utilisant soit la souris, soit le clavier. La 
seule difference est que vous entrez simplement un angle. Voyez le paragraphe Contrainte selon un Axe du mode Grab pour 
plus de détails.�� 
 

Point de Rotation (Point of rotation) 
 

Pour selectionné le point de rotation par lequel passera l'axe de rotation, utilisez les boutons 

Rotation/Scaling de l'entête de la Vue 3D, . Cela affichera le menu Pivot: .  
 
Pour la définition des entrées de ce menu, reportez-vous au chapitre II – Interaction en 3D – 
paragraphe 2.5. Les Points de Pivot (Pivot Points). 

   

Pour un contrôle plus fin ou plus de précision, utilisez CTRL  ou SHIFT. Presser CTRL fait passer en mode Snap et les 
rotations sont contraintes à des incréments de  5 degrés. Presser SHIFT en même temps, contraint la rotation à des incréments 
de 1 degré. Presser SHIFT seule pendant la rotation permet une précision encore plus fine, de l'ordre du 1/100eme de degre. 
La rotation des Objects sélectionnés peut être ramenée à sa valeur par défaut en pressant ALT R . 
Si vous débutez avec les rotations, ne vous préoccupez pas de tous ces détails. Expérimentez l'outil  : amusez-vous et 
l'expérience vous apprendra comment les points de pivot affectent la rotation. Par example, une façon simple de comprendre 
comment fonctionnent les points de pivot est de créer deux cubes. Ensuite, essayez chaque type de point de pivot tout en étant 
en mode Rotate. 

 

Conseil Pratique : Pour faire qu'un cube tourne (orbite) autour d'un autre, réglez le point de pivot à Active Object. Lors de la 
rotation, limitée ou non par un axe, l'autre Object tourne autour de l'Object actif.  
 

4.1.3.3. Retailler des Objets (Scaling objects) 
Mode : mode Edit  / mode Object – Raccourci : S ou système Gesture – Menu : Mesh>Transform>Scale.  
 

Pour activer le mode Scale, appuyez sur S ou utilisez le système Gesture. Modifiez l'échelle en déplacant la souris, confirmez 
avec LMB  ou ENTER et annulez avec RMB ou ESC.  
Le retaillage dans l'espace 3D se fait autour d'un point central; un peu comme une rotation intervient autour d'un point pivot. Si 
vous augmentez la taille de l'Object, tous les points sont éloignés du point central sélectionné; si vous la diminuez, tous les 
points se déplacent vers ce point.  

 

Contrainte de Retaillage selon un Axe (Axis of scale Constraint) 
Par défaut, les Objects sélectionnés sont retaillés uniformément dans toutes les directions. Pour modifier les proportions 
(rendre un Object plus long, plus large, etc), vous pouvez limiter le retaillage à un seul axe des coordonnées globales, de la 
même facon qu'en mode Grab ou en mode Rotate. Ce que nous avons vu sur les contraintes de déplacements et rotations 
s'applique aussi aux mises à l'echelle, que ce soit l'entrée des valeurs au clavier ou l'utilisation de la souris. Voyez le 
paragraphe Contraintes sur les axes pour plus de détails.  
De même, toutes les considérations sur la contrainte selon un axe spécifique, en mode Grab, sont valables de même que celles 
sur l'entrée de paramètres numériques.  

 

Point Central de Retaillage (Center point of scale) 
Pour sélectionner le point central du retaillage, utilisez le bouton Rotation/Scaling de l'entête de la Vue 3D, . Ceci 
affichera le menu Pivot: comme ci-dessus pour le Point de Rotation.   
Ici aussi, CTRL  fait passer en mode Snap, avec un retaillage précis par pas de 0.1. Pressez SHIFT pour un réglage précis. Le 
retaillage des Objects selectionnés peut être ramené à la valeur par défaut en pressant ALT S.  
 

Symétrie Inverse d'Objects (Mirroring objects) 
La symétrie inverse des Objects est une application differente de l'outil 
Scale. Créer la symétrie inverse d'un Object n'est en effet rien d'autre 
qu'un retaillage avec une valeur négative selon une direction. Par 
exemple, pour réaliser une symétrie inverse (ou effet miroir) selon un 
axe unique quelconque :  

· Passez en mode Scale.  
· Selectionnez un axe avec X, Y ou Z. 
· Entrez -1 comme valeur de mise à l'échelle. 
· Pressez ENTER.  

 

Le dessin ci-dessus est un exemple de symétrie inverse d'un prisme le long de l'axe Z.  
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4.1.4. Parenter et Grouper des Objets  
Il peut y avoir beaucoup d'Objets dans une Scène : une Scène typique est composée d'acteurs, d'accessoires, de Lumières et 
d'arrière-plans. Blender vous aide à garder le tout organisé en vous permettant de grouper ensemble les Objets semblables.  
Quand vous modélisez un Objet complexe, comme une montre, vous pouvez choisir de modéliser ses différentes parties en tant 
qu'Objets séparés. Toutefois, toutes ces parties peuvent être rattachées les unes aux autres.  
Le concept de relation parent-enfant est utilisé dans tous les programmes d’animation et il implique un (ou plusieurs) Objet(s) 
assigné(s) au rôle d’enfant et un Objet assigné au rôle de parent. Si le parent bouge, pivote ou est retaillé, les enfants doivent 
faire la même chose. D’un autre côté, un enfant peut se déplacer, pivoter ou être retaillé sans affecter le parent. 
  
Exemple : une main est l’enfant de l’avant-bras, tandis que celui-ci est l’enfant du 
bras supérieur et que ce dernier est l’enfant du torse. De ce fait, si l’avant-bras bouge 
(ou pivote), la main doit suivre et si le bras supérieur pivote, l’avant-bras et la main 
doivent tous deux suivre. Si le torse bouge, le bras entier doit le suivre. C’est ainsi 
que vous empêchez un corps ou une machine de partir en morceaux! 
 

4.1.4.1. Parenter des Objets (Parenting objects) 
Mode : mode Object – Raccourci : CTRL P – Menu : Object>Parent>Make 
Parent.  
 

Pour parenter des Objects, sélectionnez au moins deux Objects, et pressez CTRL P. 
Sélectionnez d’abord l’Objet enfant (ou les Objets avec SHIFT), puis sélectionnez 
l’Objet parent (l’Objet enfant doit toujours être sélectionné en premier). Une fenêtre 
de confirmation apparaîtra en vous demandant Make parent. Sélectionner Make 
parent permet de confirmer et le groupe est créé.  

 
 

Déplacer un Enfant (Move child) 
Vous pouvez placer un Object enfant à la position exacte de son parent en effaçant son origine. La relation 
entre le parent et l’enfant reste toujours active. Sélectionnez l’Object enfant et pressez ALT O .  
En confirmant Clear origin dans la boîte de dialogue, l’Objet enfant sera collé à l’emplacement du parent. Utilisez la vue 
Outliner pour vérifier que l’Objet enfant est toujours parenté.  
 

Annuler une Relation/Effacer un Parent (Remove relationship/Clear Parent) 
Vous pouvez retirer un lien de parenté parent-enfant à l'aide de ALT-P . Ceci fait 
apparaître le menu ci-contre : 
· Clear parent : Si le parent dans le groupe est sélectionné, rien ne se passe. Si 

un enfant (ou des enfants) est (sont) sélectionné(s), ils sont dissociés du parent 
(ou libérés) et ils récupèrent leurs position, rotation et taille originale.  

· Clear parent...and keep transform : Libère les enfants du parent, mais les enfants conservent la position, la rotation et la 
taille qui leur a été donnés par le parent.  

· Clear parent inverse : Place les enfants par rapport au parent comme s'ils étaient placés dans une référence globale. Ceci 
efface effectivement la transformation du parent sur les enfants. Par exemple, si le parent s'est déplacé de 10 unités le long 
de l'axe X et que l'option Clear parent inverse est activée, tous les enfants sélectionnés sont libérés et reculent de 10 
unités (-10) le long de l'axe X. L'option Clear parent inverse n'utilise que la dernière transformation; si le parent s'est 
déplacé deux fois de 10 unités à chaque fois pour un total de 20 unités, alors l'option Clear parent inverse ne fera reculer 
les enfants que de 10 unités et pas 20 unités. 

 

Exemple de Parentage 
L’Objet actif, en rose, sera fait le parent de tous les autres Objets dans le groupe. 
Les centres de tous les Objets enfants sont maintenant liés au centre du parent par 
une ligne de tirets. Ici, l'Objet parent est le cube A et l'Objet enfant est le cube B. 
Le lien est appelé L.  
 

A ce point, des transformations en déplacement, rotation et retaillage sur le parent 
seront appliquées également aux enfants. Le parentage est un outil très important 
pour de nombreuses applications avancées, comme nous le verrons dans les 
derniers chapitres et il est utilisé intensivement avec les animations avancées.  

 
 

Conseil Pratique : Il existe une autre façon de visualiser les relations parent-enfant 
dans des groupes et elle utilise la vue Outliner . L'image ci-contre est un exemple de 
l'aspect de la vue Outliner  dans le cas de notre exemple de parentage précédent. Le 
nom du cube A est ici Cube_Parent et le nom du cube B est Cube_Child.  
 

Exemple 
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Si vous voulez créer une relation parent-enfant entre quelques cylindres pour créer un bras de robot, créez un cylindre et étirez-
le en mode Edit en déplaçant les vertices d’une extrémité. Souvenez-vous de prêter une attention particulière au point de pivot 
de l’Objet. Si l’objet nécessite un pivot comme un bras, vous devrez conserver ce point à l’une des extrémités du cylindre.  Il 
est facile d’oublier ce point de pivot quand vous déplacez des vertices en mode Edit . Vous pouvez utiliser l’option Center 
Cursor du Contexte Edit  pour positionner le pivot à l’emplacement du curseur 3D. Après avoir façonné votre cylindre, 
pressez SHIFT D pour le dupliquer plusieurs fois. Positionnez les cylindres et vérifiez bien leurs points de pivot. 
 

Déplacer les pivots après avoir effectué 
la relation enfant-parent fera se déplacer 
les Objets. Commencez à une extrémité 
et sélectionnez les deux premiers Objets. 
Pressez CTRL P pour créer la relation. 
Vérifiez si c’est correct et passez à la 
série suivante. Dans cette seconde série, 
l’Objet parent précédent devient 
maintenant un Objet enfant. Créez une 
animation simple pour tester cette 
fonction. 

 
 
 
 
 

Points de pivot des 
Objets 

 

 

Objet parent 
 
 
 

Objet enfant 

 

4.1.4.2. Grouper des Objets (Grouping objects)  
Mode : mode Object – Panneau : Contexte Object > panneau Object and Links – Raccourci : CTRL G – Menu : Object > 
Parent > Add to New Group.  
 

Grouper des Objets est une façon de gérer des relations entre Objets, indépendante des méthodes habituelles comme les 
hiérarchies (parentage), les Scènes ou l'utilisation des calques (layers). 
 

Cet outil permet de grouper ensemble des Objets sans aucune sorte de relation de 
transformation. Les Objets qui font partie d'un groupe sont toujours affichés en vert clair 
quand ils sont sélectionnés.  
 

Exemple d'Objets Groupés 
L'image ci-contre montre des cubes groupés ensembles où le cube A est le dernier Objet 
sélectionné, ce qui est indiqué par sa couleur plus claire.  
  
Créer ou Ajouter à un Groupe (Adding to or Creating) 
CTRL G fait apparaître un menu Groups qui permet d'ajouter à un groupe existant (Add to existant 
Group), d'ajouter à un nouveau groupe à créer (Add to New Group) ou de retirer un (ou plusieurs)  
Objet(s) de tous les groupes existants (Remove from All Groups).   
 

Sélectionner un Groupe (Selecting) 
SHIFT G fait apparaître le menu Select Grouped pour sélectionner des Objects en se basant sur des caractéristiques de 
groupe. Ce menu contient les options suivantes :   
 
· Children : Permet de sélectionner tous les enfants des Objects actifs, ainsi que les enfants de ces 

enfants jusqu'à la dernière génération.  
· Immediate Children : Permet de sélectionner les enfants des Objects actifs, mais pas ceux du 

parent des Objects sélectionnés.  
· Parent : Permet de sélectionner le parent de l'Object actif et de désélectionner ce dernier en même 

temps.   
· Siblings (Shared Parent)  : Permet de sélectionner tous les Objets qui sont les enfants de l'Objet sélectionné. 
· Objects of Same Type : Permet de sélectionner des Objets en se basant sur le type de l'Objet actif.  
· Objects on Shared Layers : Cette option n'a rien à voir avec les parents. Elle permet de sélectionner tous les Objects qui 

partagent le (ou les) même(s) calque(s) que l'Object actif. 
· Objects in Same Group : Permet de sélectionner des Objets qui appartiennent au même groupe que le (ou les) Objet(s) 

sélectionné(s). 
 

Exemple d’Objets groupés 
  
L’image ci-contre montre des cubes groupés ensembles, où A est le dernier Objet 
sélectionné (car il est dessiné dans une couleur plus claire). 
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4.1.5. Dupliquer des Objets 
 

4.1.5.1. L'outil Duplicate 
Mode : mode Edit  / mode Object – Raccourci : SHIFT D – Menu : Object>Duplicate.  
 

Ceci créera une copie visuellement identique du (ou des) Object(s) sélectionné(s). La copie est créée à la même position que 
l'Object original et vous êtes placé automatiquement en mode Grab. Voyez l'exemple ci-dessous. 
 

Il s'agit d'un nouvel Object et il "partage" tous les matériaux, textures et images-clés IPO de l'Object original. Ce lien 
Duplicate est parfois appelé un lien superficiel (shallow link) car les informations du Maillage de l'Objet et les propriétés de 
transformation sont des copies séparées.   

 

Exemple d'utilisation de l'outil Duplicate 
 

Le cône appelé C est une duplication du cône A. Ici, il y a quelques propriétés à 
noter :  
· Le vertex en P1 a été déplacé, mais le même vertex sur le cône A est inchangé. 

Ceci veut dire que les données du maillage ont été copiées mais liées.   
· La couleur de cône C est rouge car la couleur du cône A est rouge. Ceci veut 

dire que les propriétés du matériau sont liées mais pas copiées.  
· Si vous faites pivoter le cône C, le cône A reste inchangé. Ceci veut dire que 

les propriétés de transformation sont copiées mais pas liées.  
 

Si vous voulez séparer des copies, vous devez les créer manuellement, une pour 
chaque propriété correspondante. Vous pouvez créer des matériaux séparés pour 
chacun, comme cela est décrit dans le chapitre sur les Matériaux.  

 
4.1.5.2. L'outil Linked Duplicates 
Mode : mode Edit  / mode Object – Raccourci : ALT D  – Menu : Object > Duplicate Linked.  

 

Vous avez aussi le choix de créer un lien Linked Duplicate plutôt qu'un lien Duplicate; ceci est appelé un lien approfondi 
(deep link). Ceci créera un nouvel Objet avec toutes ses données liées à l'Objet original. Si vous modifiez l'un des Objets liés 
en mode Edit , toutes les copies liées sont modifiées. Les propriétés de transformation sont toujours copiées et non liées. Faites 
référence à l'image ci-dessus (partie inférieure) pour suivre ce qui suit :  

 

Exemple   
Le cône appelé D est une duplication liée du cône B, créé en utilisant ALT D . Ici, il y a quelques propriétés à noter : 
· Le vertex en P2 a été déplacé et le même vertex sur le cône B a aussi été déplacé. Ceci veut dire que les données du 

maillage ont été liées mais pas copiées.  
· La couleur du cône D est verte car la couleur du cône  B est verte. Ceci veut dire que les propriétés du matériau sont aussi 

liées mais pas copiées.  
· Si vous faites pivoter le cône D, le cône B reste inchangé. Ceci veut dire que les propriétés de transformation sont copiées 

mais pas liées.  
 

4.1.5.3. Duplication Procédurale (Procedural Duplication)  
Mode : Mode Object / Mode Edit  – Panneau : Anim settings – Raccourci : F7. 
 

Une fois que nous avons surmonté la fièvre occasionnée par la modélisation par extrusion, et que nous commençons à 
considérer d'autres défis de modélisation, nous sommes prêts à rechercher des méthodes alternatives pour effectuer le travail. Il 
existe un groupe de techniques de modélisation dans Blender qui non seulement rend notre travail de modélisateur plus facile, 
mais qui parfois le rend effectivement possible ! Ces techniques de modélisation, appelées duplications procédurales, 
concernent non seulement des manipulations au niveau du vertex, mais également l'utilisation de procédures non intuitives qui 
nécessitent une connaissance (ou une expérience) plus approfondie de la part de l'utilisateur et qui ne sont pas à la portée du 
débutant.  
 

Dans ce chapitre, nous allons décrire ces techniques en détail et expliquer leur utilité dans plusieurs exemples de modélisations 
qui n'auraient pas pu être résolus autrement. 
 

Il existe quatre façons d’effectuer une duplication procédurale d’Objets dans Blender :  
· Mode DupliVerts  
· Mode DupliFaces 
· Mode DupliGroup 
· Mode DupliFrames  

 

Les boutons pour ces options sont trouvées dans le panneau Anim settings du Contexte Object (F7) et sont expliqués ci-
dessous. 
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Conseil Pratique : Si vous voulez que les propriétés de Transformation soient liées, voyez le paragraphe 1.4. Parenter et 
Grouper des Objets. 
�� 
4.1.5.3.1. L'outil Dupliverts (Duplications sur Vertices) 
Mode : mode Object – Panneau : Anim Settings > Bouton Dupliverts – Raccourci : F7.  
 

Les DupliVerts  sont la contraction de DUPLIcation at VERTiceS, c'est-à-dire la duplication d'un Objet de base à 
l'emplacement des vertices d'un maillage (ou même d'un système de particules). En d'autres termes, quand vous utilisez l'outil 
Dupliverts sur un maillage, une copie (ou instance) de l'Objet de base est placée sur chaque vertex du maillage. 
 

Il y a deux approches de modélisation par utilisation de l'outil DupliVerts . Il peut être utilisé comme un outil d'arrangement, 
pour modéliser un arrangement géométrique d'Objets (ex: les colonnes d'un temple grec, les arbres d'un jardin, une armée de 
soldats-robots, les chaises dans une salle de cours, ....). L'Objet peut être de n'importe que type supporté par Blender. 
 

La seconde approche est de l'utiliser pour modéliser un Objet en commençant à partir d'une partie de lui-même (ex: les pointes 
d'une massue, les piquants d'un oursin, les tuiles d'un mur, les pétales d'une fleur, ...). 
 
L'outil DupliVerts comme Outil d'Arrangement   

(DupliVerts as an Arranging Tool) 
 

Tout ce qu'il vous faut, c'est un Objet de base (ex : un "arbre" ou une "colonne") et un maillage 
dont les vertices correspondent au motif (ou implantation) auquel vous pensez. 
 
Nous allons maintenant utiliser une Scène simple. Elle est constituée d'une Caméra, de 
Lumières, d'un plan (pour le sol) et d'un homme étrange modélisé d'après un fameux 
personnage de Magritte  (image ci-contre).  
 

 
 

De toute façon, ce 
personnage sera notre 
"Objet de base".  
C'est une bonne idée de le 
positionner au centre du 
système de coordonnées et 
d'avoir annulé toutes ses 
rotations.  
Déplacez le curseur vers le 
centre de l'Objet de base, et 
dans la vue Top, ajoutez un 
cercle Mesh, avec 12 
vertices environ (image ci-
contre). 

 

 

Hors mode Edit , 
sélectionnez l'Objet de base 
et ajoutez le cercle à la 
sélection (l'ordre est très 
important, ici).  
Parentez l'Objet de base 
avec le cercle en pressant 
CTRL P.  
Maintenant, le cercle est le 
parent du personnage 
(image ci-contre).  
Nous avons presque 
terminé! 

 
 

 

 

 

Maintenant, sélectionnez seulement le cercle, passez dans le contexte Object (via  
ou F7) et sélectionnez le bouton DupliVerts  dans le panneau Anim settings (image ci-
contre). 
 
Ne vous inquiétez pas pour l'Objet au centre (image ci-contre).  
Il est toujours visible dans les Vues 3D, mais il ne sera pas rendu.   
 
 

Vous pouvez maintenant sélectionner l'Objet de base, le modifier (retaillage, 
rotation, édition en mode Edit [et aussi en mode Object, toutefois le retaillage 
dans ce mode peut conduire à certains problèmes quand vous appliquerez une 
rotation sur le DupliVerts  comme nous le verrons plus loin]) et tous les Objets 
DupliVerted reflèteront ces modifications. Mais la chose la plus intéressante à 
noter, c'est que vous pouvez aussi éditer le cercle parent. 
 

Note : L'Objet de base n'est pas rendu si l'outil DupliVerts  est appliqué à un 
maillage, mais il le sera si l'outil DupliVerts  est appliqué à un système de 
particules!  
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Sélectionnez le cercle et retaillez-le. Vous pouvez voir que les hommes mystérieux sont 
uniformément retaillés avec lui.  
Maintenant, passez en mode Edit  pour le cercle, sélectionnez tous ses vertices (A) et 
agrandissez-le trois fois. 
 

Quittez le mode Edit  et les Objets DupliVerted seront mis à jour (image ci-contre). 
Cette fois, ils ont conservé leur taille d'origine, mais c'est la distance qui les sépare qui a 
été modifiée.  
Non seulement vous pouvez retailler en mode Edit , mais vous pouvez aussi supprimer ou 
ajouter des vertices pour modifiez l'arrangement des personnages.  
 

Sélectionnez tous les vertices en mode Edit  et dupliquez-les (SHIFT D).  
Maintenant, agrandissez les nouveaux vertices vers l'extérieur pour obtenir un second cercle 
autour de l'original.  
 

Quittez le mode Edit , et un second cercle d'hommes apparaîtra (image ci-contre). 
 

Jusqu'à maintenant, tous les hommes de Magritte  font face à  la caméra et s'ignorent 
mutuellement. Vous pouvez obtenir des résultats plus intéressants en utilisant le bouton Rot 
juste à côté du bouton DupliVerts  dans le panneau Anim settings. Si ce bouton est activé, 
vous pouvez faire pivoter les Objets DupliVerted en accord avec les normales de l'Objet 
parent.  
Plus précisément, les repères d'axes des Objets DupliVerted sont alignés avec la normale du vertex de leur emplacement. 
 

L'axe qui sera aligné (X, Y ou Z) avec la normale du maillage parent dépend des 
indications données par les boutons TrackX , Y, Z et  UpX, Y, Z en haut du panneau Anim 
settings. Essayer ceci sur vos hommes bizarres peut conduire à des résultats bizarres en 
fonction des réglages effectués. 
La meilleure façon de comprendre ce qui arrivera est premièrement d'aligner les repères 
d'axes des Objets "base" et "parent" avec le repère d'axes du monde (World). Cela est fait 
en sélectionnant les deux Objets, en pressant CTRL A  et en cliquant sur le menu Apply 
Size/Rot? . 
Puis, rendez visibles les repère d'axes de l'Objet de base et le repère d'axes et les normales 
de l'Objet parent (image ci-contre - dans ce cas, comme nous avons un cercle sans faces, 
une face doit d'abord être définie pour que la normale soit visible - et existe réellement).  
 

Maintenant, sélectionnez l'Objet de base (notre homme de Magritte ) et amusez-vous avec les boutons de Tracking. Notez les 
différents alignements des axes avec les différentes combinaisons de UpX, Y, Z et TrackX , Y, Z (voir les quatre images ci-
dessous). 
 

 
L'axe Y négatif est aligné avec les normales des vertices 

(pointant vers le centre du cercle)  

 
L'axe Y positif est aligné avec les normales  

 
L'axe X positif est aligné avec les normales  

 
L'axe Z positif est aligné avec les normales (bizarre, non?)  
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L'outil DupliVerts pour modeler un unique Objet   
(DupliVerts to Model a Single Object) 

 
Des modélisations très intéressantes peuvent être obtenues en utilisant l'outil DupliVerts et 
une primitive standard. 
 

Partez d'un cube dans la vue Front , et extrudez-le plusieurs fois pour obtenir quelque chose 
comme le tentacule de l'image ci-contre (en version maillage et avec l'option SubSurfs 
activée).  
 

Puis, ajoutez une Icosphère avec 2 subdivisions. 
 

 

Assurez-vous soigneusement que le tentacule soit bien situé au centre de la sphère et que le repère 
d'axes du tentacule et de la sphère soient bien alignés avec le repère d'axes du monde [World ]  
(image ci-contre). 
 
Maintenant, faites de l'Icosphère le parent du tentacule.  
 
Sélectionnez l'Icosphère seule et cliquez sur le bouton DupliVerts  dans le panneau Anim settings 
(image ci-dessous à gauche). 
 
Cliquez sur le bouton Rot pour faire pivoter les tentacules (figure ci-dessous à droite) 

   

  
 

Une fois de plus, pour faire que le tentacule pointe vers l'extérieur, vous devez examiner soigneusement ses axes. Quand vous 
appliquez Rot, Blender essayera d'aligner l'un des axes du tentacule avec le vecteur Normal du vertex correspondant sur le 
Maillage parent. 
 
Vous ne vous êtes pas préoccupé du cercle parent des hommes de Magritte , mais ici 
nous devons faire attention à la sphère, et vous noterez bientôt qu'elle n'est pas 
rendue. Vous voudrez probablement ajouter une sphère supplémentaire qui sera 
visible lors d'un rendu, pour compléter le modèle.  
Vous pouvez vous amuser en mode Edit  avec le tentacule, en éloignant ses vertices 
du centre de la sphère, mais le centre de l'Objet doit toujours être au centre de la 
sphère de façon à obtenir une figure symétrique. Toutefois, faites attention de ne pas 
augmenter ou diminuer la taille selon un seul des axes, en mode Object, car cela 
conduirait à des résultats imprévisibles sur les Objets DupliVerted quand le bouton 
Rot est activé. 
 

Le modèle final 
Quand la modélisation est terminée et que vous êtes satisfait du résultat, vous pouvez 
sélectionner le tentacule, presser SHIFT CTRL A  et cliquer sur le menu Make 
duplis real ? pour transformer vos copies virtuelles en de véritables Maillages 
(image ci-contre). 

 

 



 IV - 11 

4.1.5.3.2. L'outil DupliFaces (Duplications sur Faces) 
Mode : mode Object – Panneau : Anim Settings > Bouton DupliFaces – Raccourci : F7.  
 

Cet outil permet de créer des instances de tous les enfants de cet 
Objet sur chaque face (uniquement pour les Maillages). 
L'option Scale permet d'utiliser la taille de la face pour retailler 
l'instance. Cet outil est une variante du précédent.  

  
 

4.1.5.3.3. L'outil DupliGroup (Duplications de Groupes) 
Mode : mode Object – Panneau : Anim Settings > Bouton DupliGroup  – Raccourci : F7.  
 

Cet outil vous permet de créer une instance d'un groupe avec la transformation d'un Objet.  
 

Utilisation de Base 
· Créez un Groupe d'Objets en sélectionnant les Objets à grouper et en pressant CTRL G > 

Add to new group. 
· Pour nommer le Groupe, sélectionnez l'un des Objets dans le groupe que vous venez de 

créer et pressez F7 pour passer dans le Contexte Object. Editez le nom affiché dans le 
champ GR:.  

· Sélectionnez Add > Group > nom du groupe que vous venez de créez.  
 

Outil DupliGroup et  Liaison Dynamique (DupliGroup and Dynamic Linking) 
Vous pouvez lier dynamiquement des Groupes depuis un fichier .blend vers un autre fichier .blend (pour les détails, voyez le 
paragraphe 3.3. Utiliser des Bibliothèques Reliées (Using Linked Libraries). Quand vous faites cela, le Groupe lié n'apparaît 
nulle part dans votre Scène tant que vous n'avez pas créé un Objet qui contrôle l'endroit où doit apparaître l'instance du Groupe.  
 

Exemple : 
· Liez un Groupe depuis un autre fichier dans votre Scène.  
 

A partir de la, vous pouvez utiliser deux méthodes :  
 

La méthode facile :  
· Sélectionnez Add > Group > nom du groupe que vous venez de créez.  
 

La méthode difficile :  
· Sélectionnez Add > Empty, et sélectionnez l'Empty que vous venez d'ajouter.  
· Passez au Contexte Object avec F7.  
· Cliquez sur le bouton DupliGroup .  
· Dans le champ GR:, tapez le nom du Groupe que vous venez de lier.  
 

A cet instant, une instance du Groupe doit apparaître. Vous pouvez dupliquer l'Empty, et les réglages pour l'outil DupliGroup  
sera préservé pour chaque Empty. De cette façon, vous pouvez obtenir très facilement des copies multiples des données liées.  

 

Armatures 
Les duplications de Groupe peuvent être animés en utilisant des Actions, ou peuvent être obtenus à partir d'un Objet Proxy 
(voyez le chapitre 1.3.5.5. Les Objets Proxy (Proxy Objects)). 
 

Souvent, vous voudrez animer le Groupe lié – mais par défaut, vous ne pouvez déplacer aucun Objet individuellement dans le 
Groupe! Si vous utilisez des Objets DupliGroup et des Objets Proxy,  vous pouvez créer de multiples instances du Groupe lié. 
Un Objet Proxy est capable de contrôler toutes les instances d'un Groupe. Il n'est toutefois pas encore possible d'avoir un Objet 
Proxy par instance de Groupe.  
 

Pour animer avec des Armatures :  
· Liez un Groupe contenant une Armature depuis un autre fichier dans votre Scène.  
· Sélectionnez Add > Group > nom du groupe que vous venez de créez.  
· Dans la Vue 3D, sélectionnez l'Empty qui contrôle la nouvelle instance du Groupe, et pressez CTRL ALT P . Sélectionnez 

l'Armature et vous aurez un Objet Proxy pour elle.  
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4.1.5.3.4. L'outil DupliFrames (Duplications sur Cellos) 
Mode : mode Object – Panneau : Anim Settings > Bouton DupliFrames – Raccourci : F7.  
 

Vous pouvez considérer les DupliFrames de deux façons différentes : comme outil d'arrangement ou comme outil de 
modélisation. D'une certaine manière, l'outil DupliFrames est similaire à l'outil DupliVerts . La seule différence est qu'avec 
DupliFrames nous arrangeons nos Objets en les faisant suivre une courbe au lieu d'utiliser les vertices d'un maillage. 
 

DupliFrames est un raccourci pour DUPLIcation at FRAMES et c'est une technique de modélisation très pratique pour des 
Objets qui se répètent le long d'un chemin, comme les traverses en bois d'une ligne de chemin de fer, les piquets d'une clôture 
ou les maillons d'une chaîne, mais aussi pour modéliser des Objets à courbes complexes comme des tire-bouchons, des 
coquillages ou des spirales. 
 

Notez que seules les animations du niveau Objet (courbes IPO Object ou courbes IPO Parent) sont dupliquées, pas celles par 
Déformations ou par Modificateurs. 
 

Modéliser avec l'outil DupliFrames (Modelling using DupliFrames) 
Nous allons modéliser une chaîne avec ses maillons en utilisant l'outil DupliFrames. 
 
Tout d'abord, pour expliquer l'utilisation de cet outil comme technique de modélisation, nous 
allons commencer par modéliser un seul maillon. Pour cela, ajoutez dans la vue Front , un 
cercle de type Curve (Bézier ou NURBS, comme vous voulez). 
 
En mode Edit , subdivisez-le une fois et déplacez un peu ses vertices pour obtenir le contour 
d'un maillon (image ci-contre) 
 

 
 

Quittez le mode Edit , et ajoutez un cercle de type Surface (image ci-contre).  
 

Les Surfaces NURBS sont idéales dans ce cas, car nous pouvons en modifier facilement la 
résolution après création, et si nous en avons besoin, nous pouvons les convertir en un Objet 
maillé (Mesh).  
 

Il est très important que nous ne confondions pas un cercle de type Curve et  un cercle de 
type Surface :  
 

Le premier type agira comme la forme du maillon mais ne nous permettra pas ensuite 
d'obtenir l'étape du Skinning (enveloppe).  
 

Le second type agira comme une "coupe transversale" pour notre Skinning.    
 
Maintenant, parentez le cercle de type Surface avec le cercle de type Curve (le contour 
du maillon) en tant que parent Normal (pas de contrainte Curve Follow).  
 
Sélectionnez la courbe (Curve) et dans le contexte Object et dans le panneau Curve 
and Surface, cliquez sur les boutons CurvePath et CurveFollow (image ci-contre). 
 

 
 

Il est probable que le 
cercle de type Surface 
apparaîtra mal 
positionné par rapport à 
la courbe.  
 
Sélectionnez-le 
simplement et appuyez 
sur ALT O  pour 
réinitialiser son origine 
(image ci-contre). 

 

Si vous appuyez sur ALT A , le cercle 
suivra la courbe.  
 
Maintenant, vous devrez certainement 
ajuster les boutons d'animation TrackX , Y, 
Z et UpX, Y, Z, pour faire que le cercle se 
déplace perpendiculairement à la courbe 
(image ci-contre). 
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Les boutons DupSta: et DupEnd: contrôlent le début (Start) et la 
fin (End) de la duplication. 
Le bouton DupOn: indique le nombre de duplications dans la série. 
Le bouton DupOff:  indique le nombre de duplications omises 
(Offset) dans la série. 

Maintenant, sélectionnez le 
cercle de type Surface, allez 
dans le panneau Curve and 
Surface et activez le bouton 
DupliFrames. Un certain 
nombre de copies (ou instances) 
de la coupe transversale 
circulaire apparaîtront le long de 
la courbe servant de chemin 
(image ci-contre). 
Vous pouvez ajuster le nombre 
de cercles que vous souhaitez 
avoir avec les boutons DupSta:, 
DupEnd:, DupOn: et DupOff: . 

 

Par exemple, DupOn = 3 et 
DupOff =2 => 3 affichés + 2 
vides + 3 affichés + 2 vides, etc.. 
Si vous voulez que le maillon soit 
ouvert, essayez un réglage 
différent pour DupEnd (image 
ci-contre).Car ici, DupEnd: 35 
terminera le maillon avant la fin 
de la courbe. 

 

 

 

Pour transformer cette structure en un 
Objet NURBS réel, sélectionnez le 
cercle de type Surface et pressez sur 
CTRL SHIFT A . Cliquez sur le menu 
Ok ? Make Dupli's Real qui apparaît 
(image ci-contre).  
 

Ne désélectionnez rien. Nous avons 
maintenant une collection de NURBS 
formant le contour de votre Objet, mais 
elles ne sont pas encore Skinned, de 
sorte que nous ne pouvons toujours pas 
les visualiser dans une prévisualisation 
Shaded ou dans un rendu. 

 

Pour obtenir cela, nous devons 
joindre tous les anneaux en un 
seul Objet. Sans désélectionner 
aucun anneau, appuyez sur 
CTRL J  et confirmez dans le 
menu qui apparaît (Join selected 
NURBS ?). 
 

Maintenant, passez en mode Edit 
pour l'Objet nouvellement créé et 
appuyez sur A pour sélectionner 
tous les vertices (Image ci-
contre).  
 

 
 

 
 

Maintenant, nous sommes prêts pour skinner (envelopper) notre Objet. Appuyez sur F et Blender génèrera automatiquement 
un Objet solide. Cette opération est appelée Skinning. 
 

Quand vous quittez le mode Edit , vous pouvez maintenant voir l'Objet en mode Shaded. 
Mais il est très sombre. Pour corriger cela, passez en mode Edit  et sélectionnez tous les 
vertices, puis appuyez sur W. Sélectionnez Switch Direction dans le menu et quittez le mode 
Edit . L'Objet est maintenant correctement dessiné (image ci-contre).  
 

L'Objet que nous avons créé, est un Objet NURBS. Cela signifie que vous pouvez toujours  
l'éditer. Et ce qui est encore plus intéressant, vous pouvez toujours contrôler sa résolution via 
les boutons du contexte Edit . 
Ici, vous pouvez fixer la résolution de l'Objet en utilisant les boutons ResolU et ResolV, donc 
vous pouvez les ajuster pour travailler en basse résolution avec l'Objet et ensuite les régler en 
haute résolution pour votre rendu final. Les Objets NURBS sont aussi très petits en tailles de 
fichiers pour sauvegarder des Scènes. Comparez la taille d'une Scène NURBS à celle de la 
même Scène dans laquelle tous les Objets ont été convertis en Maillages avec ALT C . 

 

Finalement, vous pouvez effacer la courbe qui nous a servi à donner une forme à votre maillon, car nous n'en avons plus 
besoin. 
 

Arranger des Objets avec l'outil DupliFrames  
(Arranging objects with DupliFrames) 

 

Maintenant, nous allons continuer à modéliser la chaîne elle-même. Pour cela, ajoutez  
simplement une courbe de type Path (nous pourrions utiliser une autre sorte de courbe, 
mais celle-ci donne de meilleurs résultats).  
 

En mode Edit , déplacez ses vertices jusqu'à ce que vous ayez obtenu la forme désirée de 
la chaîne (image ci-contre).  
 

Si vous n'utilisez pas une courbe  Path, vous devez cocher le bouton 3D, dans les 
boutons du contexte Edit  pour que la chaîne soit réellement en 3D.  
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Sélectionnez l'Objet Maillon  que nous venons de modéliser à l'étape précédente et 
parentez-le avec la courbe de la chaîne, de nouveau comme parent Normal.  
 
Comme nous utilisons une courbe Path, l'option CurvePath dans le panneau Curve 
and Surface sera activée automatiquement, toutefois, l'option CurveFollow ne le sera 
pas, donc vous devez l'activer (image ci-contre). 
  
 

Si le maillon n'est pas placé correctement sur la courbe, sélectionnez-le et pressez sur 
ALT O  pour réinitialiser son origine. Pour l'instant, nous n'avons rien fait d'autre qu'animer le 
maillon le long de la courbe. Ceci peut être vérifié en déroulant l'animation avec ALT A . 
Maintenant, sélectionnez le maillon et de nouveau allez dans le contexte Object et dans le 
panneau Anim settings. Là, activez l'option DupliFrames. Jouez avec les valeurs des boutons 
numériques DupSta:, DupEnd: et DupOf: . Normalement, nous devrions utiliser un DupOf: 0, 
mais pour une chaîne, si en utilisant DupOf: 0, les maillons sont trop proches les uns des 
autres, vous devrez diminuer la valeur PathLen de la courbe Path dans le panneau Curve and 
Surface du contexte Edit  et ensuite, modifier en conséquence la valeur DupEnd: du maillon 
avec la même valeur (image ci-contre). 

 

 
 

 
Nous avons besoin que le maillon pivote le long de la courbe d'animation, de sorte que 
nous ayons chaque maillon qui subisse une rotation de 90 degrés par rapport à son 
prédécesseur dans la chaîne.  
Pour cela, sélectionnez le maillon et activez le bouton Axis dans le contexte Edit pour 
faire apparaître le repère d'axes de l'Objet. Insérez une image-clef Rotation pour l'axe qui 
est parallèle à la courbe. Avancez de 3 ou 4 cellos et faites lui subir une rotation autour de 
cet axe en pressant R suivi de X-X (X 2 fois), Y-Y ou Z-Z pour que la rotation se fasse 
autour de l'axe local X, Y ou Z (image ci-contre).  
 

 
Ouvrez une fenêtre IPO pour éditer la rotation du maillon le long de la courbe 
Path. Validez Extrapolation Mode de façon que le maillon continue sa rotation 
jusqu'à la fin de la courbe Path.  
 
Vous pouvez éditer la courbe IPO Rotation pour que le maillon pivote 
exactement de 90° tous les 1, 2 ou 3 maillons (chaque maillon correspond à un 
cellos).  
 
Utilisez N pour positionner exactement un nœud à X = 2.0 et Y = 9.0, ce qui 
correspond à 90° en 1 cellos (du cellos 1 au cellos 2). 
 
Et vous obtenez une magnifique chaîne (image ci-contre)! 
 

 
Animation et Modélisation (More Animation and Modelling) 
Vous n'êtes pas limité à l'utilisation de courbes de type Path pour modéliser votre réalisation. Elles ont été utilisées ici 
simplement parce qu'elles semblaient plus pratiques dans ce cas-là, mais dans d'autres cas, elles ne sont pas indispensables. 
 

Dans la vue Front , ajoutez un cercle de type Surface (image ci-dessous à gauche). Subdivisez-le une fois, pour qu'il ressemble 
plus à un carré. Déplacez et retaillez un peu quelques vertices pour lui donner une forme trapézoïdale (image ci-dessous à 
droite). 

 
 

 

Puis faites pivoter tous les vertices de quelques degrés.   
 
Grabbez tous les vertices et déplacez-les de quelques unités vers la droite ou la gauche sur l'axe 
X (mais sans modifier la position en Z). Vous pouvez utiliser CTRL  pour obtenir ceci avec 
précision. Quittez le mode Edit .  
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A partir de maintenant, la seule chose qui nous reste à faire est d'éditer les courbes 
d'animation IPO. Donc, nous pouvons appeler cela "Modélisation par Animation". 
Nous n'aurons plus besoin de passer en mode Edit  pour la surface. 
 
Passez en vue Top. Insérez une image-clef d'animation Rot au cellos 1. Avancez de 
10 cellos et faites subir à la surface une rotation de 90° par rapport à sa nouvelle 
origine. Insérez une nouvelle image-clef Rot. Ouvrez une fenêtre IPO et activez 
Extrapolation Mode pour la courbe IPO Rot (image ci-contre). 
 

 
 

 
Revenez au cellos 1 et insérez une image clef  Loc. Passez en vue Front .  
 
Allez au cellos 11 (appuyez simplement sur UPARROW) et déplacez la surface 
de quelques unités selon l'axe Z.  
 
Insérez une nouvelle image-clef Loc. Dans la fenêtre IPO,  réglez la courbe 
LocZ en mode Extrapolation (image ci-contre). 
 

 
 

Maintenant, bien sûr, allez dans les boutons Animation et appuyez sur 
DupliFrames. Vous pouvez voir comment notre surface monte en spirale à 
travers l'espace 3D en formant quelque chose ressemblant à un ressort.  
 
C'est bien, mais nous en voulons plus. Désactivez DupliFrames pour continuer. 
 
Dans le cellos 1, retaillez la surface à presque zéro et insérez une image-clef Size. 
Avancez au cellos 41, et rétablissez la taille initiale avec ALT S. Insérez une 
nouvelle image-clef Size. Cette courbe IPO ne doit pas être en mode 
Extrapolation car nous ne voulons pas la retailler à l'infini (image ci-contre). 

 
 

Si vous activez maintenant DupliFrames, vous verrez apparaître un 
beau contour de tire-bouchon (image ci-contre).  
 

De nouveau, il vous faudra utiliser les étapes suivantes : CTRL SHIFT 
A > Make Duplis Real, fusionner les surfaces (CTRL J ), sélectionner 
tous les vertices, réaliser le Skinning (F), inverser la direction des 
normales et enfin, quittez le mode 
Edit (image ci-dessous). 
 
Vous pouvez voir que c'était un exemple très 
simple. Avec plus d'édition de la courbe IPO, 
vous pourrez obtenir des modèles plus 
complexes et plus intéressants.  
 
Laissez libre cours à votre imagination. 
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4.1.6. Tracking (Pointer vers un Objet)  
Mode : mode Object – Panneau : Object>Constraints – Raccourci : CTRL T  – Menu : Object>Track>Make Track .  
 

Le Tracking consiste en un Objet qui "regarde" (suit) toujours un autre Objet.  L'observateur est le "tracker" et l'observé est la 
"cible". Si la cible bouge, le tracker pivote; si le tracker se déplace, il pivote en même temps. Dans les deux cas, le tracker 
maintient une visée constante sur la cible.����
 

Les Options du Tracking 
Pour faire qu'un (ou plusieurs) Objet(s)s suive(nt) un autre Objet (la cible), sélectionnez au moins deux 
Objets et utilisez CTRL T . Le menu Make Track propose alors plusieurs options :  

 
TrackTo Constraint : Cette option fait que l'Objet Tracker  pointe vers sa cible selon son axe 
local To avec un autre axe Up toujours maintenu avec une orientation verticale. Ce Tracking 
est similaire au Tracking d'un panneau d'affichage (billboard tracking) en 3D. C'est la méthode 
à préférer à la méthode Old Track . C'est une méthode de Tracking à utiliser de préférence car 
elle possède un mécanisme de contrainte plus aisément contrôlable. Elle peut aussi agir 
comme une contrainte dans la pile des contraintes et peut être déplacée vers le haut ou vers le 
bas dans cette pile. Les commandes pour modifier le Tracking et l'axe Up sont localisées dans 
le panneau Constraints (image ci-contre). Ce panneau se trouve au même endroit que les 
panneaux Anim settings et Draw.  

 

 
Les champs du panneau Constraints sont : 
· Target : Le nom  de la cible que l'Objet Tracker  suit.  
· To : L'axe de Tracking. Il ne peut pas être le même que l'axe Up.  
· Up : L'axe orienté Up relativement au système de coordonnées globales.  
· Influence : Ceci contrôle la précision avec laquelle l'Objet Tracker suit la cible. 0 indique que la contrainte est 

désactivée. L'Objet Tracker  restera verrouillé en orientation. 1 indique que le Tracking est complètement activé et que 
l'axe de Tracking restera étroitement focalisé sur la cible.  

· Show : Ceci ajoute un canal IPO Influence à la contrainte s'il en existe une. Vous pouvez alors ajouter des images-clés au 
canal.  

· Key : Ceci ajoute des images-clés d'animation au canal IPO Influence. C'est une combinaison très puissante. Par exemple, 
vous pourriez avoir une caméra avec une option TrackTo Constraint  et avoir une entrée qui dirige le canal Influence.  

 

Si vous sélectionnez une combinaison invalide d'axe de Tracking et d'axe Up, le champ nommé AutoTrack  deviendra rouge. 
De plus, l'Objet Tracker  s'arrêtera de suivre la cible tant que vous n'aurez pas choisi une combinaison valide. Le 
comportement est différent de celui de la méthode Old Track , car celle-ci continuait le Tracking  en utilisant une combinaison 
valide précédente.  
 

Exemple d'utilisation de l'option TrackTo Constraint  
 

L'image ci-contre est un exemple d'un cube qui utilise l'option TrackTo 
Constraint. Le cube A suit le cube B et L est la ligne de Tracking. Notez comment 
le repère Local de l'Objet en utilisant le bouton Axis du panneau Draw. Vous 
pouvez clairement visualiser l'axe de Tracking et l'axe Up. Le réglage de la 
contrainte sur le cube A apparaît dans l'image précédente : +X est l'axe de Tracking 
et +Z est l'axe Up. 

 
 

Vous pouvez aussi voir dans l'image du panneau Constraints précédente, que le cube A suit quelque chose en regardant le 
champ Target. Nous pouvons voir que le cube A suit le cube B car le nom du cube B est OB:Cube. Vous pouvez rediriger le 
Tracking vers un autre Objet, simplement en entrant ici le nom d'un autre Objet.  

 

LockTrack Constraint : Cette option fait que l'Objet Tracker pointe vers sa cible selon 
son axe local To avec un axe Lock toujours fixe et incapable de rotation. Ce Tracking est 
similaire au Tracking d'un panneau d'affichage (billboard tracking) en 2D. Cette contrainte a 
toujours un axe verrouillé de manière qu'il ne puisse pas pivoter. Un exemple de panneau 
d'affichage est d'avoir un Objet Plane texturé avec l'image d'un arbre qui fera toujours face à 
la caméra. Les commandes pour modifier l'axe de Tracking et l'axe Lock sont localisées 
dans le panneau Constraints (image ci-contre). Ce panneau se trouve au même endroit que 
les panneaux Anim settings et Draw.  

 

Les champs du panneau Constraints sont : 
· Target : Le nom  de la cible que l'Objet Tracker  suit.  
· To : L'axe de Tracking. Il ne peut pas être le même que l'axe Lock.  
· Lock  : L'axe verrouillé relativement au système de coordonnées globales. Le repère d'axes Local de l'Objet Tracker  se 

collera (snap) à un repère d'axes Global.. 
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· Influence : Ceci contrôle la précision avec laquelle l'Objet Tracker suit la cible. 0 indique que la contrainte est 
désactivée. L'Objet Tracker  restera verrouillé en orientation. 1 indique que le Tracking est complètement activé.  

· Show : Ceci ajoute un canal IPO Influence à la contrainte s'il en existe une. Vous pouvez alors ajouter des images-clés au 
canal.  

· Key : Ceci ajoute des images-clés d'animation au canal IPO Influence. Cette contrainte fonctionne très bien pour des 
arbres 2D collés sur un panneau d'affichage.  

 

Pour des détails supplémentaires, voyez l'option TrackTo Constraint . Les options LockTrack Constraint  et TrackTo 
Constraint sont très similaires sauf que la première possède un axe verrouillé et la seconde un axe Up.  
 

Old Track  : Cette option correspond à un ancien algorithme (antérieur à la version 2.30 de Blender) et est similaire à l'option 
TrackTo Constraint  en ce sens qu'aucun axe n'est verrouillé. Cet algorithme essaie de conserver un axe To pointé sur la cible. 
L'Objet Tracker termine généralement dans une position bizarre quand cette contrainte est appliquée au premier abord. Afin 
d'obtenir des résultats corrects, utilisez ALT R  quand vous appliquez ou que vous modifierez l'axe de Tracking ou l'axe Up. 
Toutefois, la méthode à utiliser de préférence est l'option LockTrack Constraint . 
 

Assurez-vous que vous avez sélectionné l'option Old Track  dans le menu Make Track avec 
deux cubes sélectionnés (image ci-contre). Par défaut, le (ou les) Objet(s) inactif(s) suit(vent) 
l'Objet actif de sorte que leur axe Local +Y pointe vers l'Objet ciblé. Ici, le cube A suit le cube 
B en utilisant la contrainte Old Track . Vous pouvez voir que l'axe +Y de A pointe vers B, 
mais a une mauvaise orientation. C'est ce qui arrive typiquement si l'Objet avait déjà une 
rotation propre. Vous pouvez produire un Tracking correct en abandonnant la rotation de 
l'Objet Tracker  en utilisant ALT R . 

 
 

L'orientation de l'Objet Tracker  est aussi réglée de telle façon que l'axe Up choisi pointe vers le haut.  
 

Si vous voulez modifier ceci, vous devez aller dans le panneau Anim settings ou se 
trouvent les réglages de l'option Old Track . Premièrement, sélectionnez l'Objet 
Tracker  (et pas la cible) et passez en contexte Objet en cliquant l'icône , ou en 
tapant F7 (voir image ci-contre). 

 

 

Vous avez alors l'option de sélectionner l'axe de Tracking à partir de la première série de six boutons radios (TrackX/Y/Z/-
X/-Y/-Z ) et/ou de sélectionner l'axe Up à partir de la série suivante (UpX/Y/Z ) dans le panneau Anim setting. Chaque fois 
que vous modifiez l'axe Up, vous devez appliquer ALT R , sinon l'Objet Tracker continuera à suivre avec l'ancienne 
orientation. C'est l'un des inconvénients de l'utilisation de l'option Old Track .  
 

Pour effacer ou retirer une contrainte de Tracking, sélectionnez l'Objet Tracker  et pressez ALT T . Comme pour l'effacement 
d'une contrainte de parentage, vous devez choisir entre perdre ou sauvegarder la rotation imposée par le Tracking.  
Note : ALT R  ne fonctionne qu'avec la contrainte Old Track .  
 

Conseil Pratique : L'Objet actif devient toujours l'Objet cible à suivre. Sauf pour l'option Old Track , une ligne de tirets bleus 
est dessinée entre l'Objet Tracker  et l'Objet cible pour indiquer qu'une contrainte de Tracking est en place entre les Objets 
correspondants. Si vous voyez un Objet suivre un autre Objet sans cette ligne de tirets bleus, alors vous savez que l'Objet 
Tracker  utilise la contrainte Old Track .  
 

En cas de réglages incorrects du Tracking (Invalid Tracking or settings) 
Si vous choisissez un axe de Tracking et/ou un axe Up invalides, l'Objet Tracker  conserve son orientation et ignore les 
sélections incorrectes. Par exemple, si vous choisissez l'axe +Z comme axe de Tracking et aussi l'axe +Z comme axe Up, vous 
avez choisi une combinaison invalide car vous ne pouvez avoir l'axe +Z de l'Objet Tracker  faisant deux choses différentes en 
même temps.  
Si vous avez des problèmes à régler correctement les axes de Tracking et Up, vous pouvez vouloir activer le repères d'axes 
Local de l'Objet Tracker .  Vous pouvez faire cela en cliquant le bouton Axis dans le panneau Draw.  
  


